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Excel (Giant) Handout (3/11/19) 

 
Your first thought when Excel is mentioned may be that you have no need to learn it.  I would still encourage you to 
have a look.  It is a wonderful medium for creating lists (Investments, expenses, passwords, names and address or 
a budget) and doing simple arithmetic operations such as totaling, averaging or computing percentages.  Once you 
see the basics you will likely find in very useful.  Many commands on the Ribbons at the top are similar to Word, so 
it is not like taking on a completely new concept. 

 
Excel is a spreadsheet processor that is an outgrowth of Lotus 1-2-3 and Symphony.  It is a Microsoft Product that 
is part of Microsoft Office (all versions) along with Microsoft Word and PowerPoint.  Additional components, such as 
Publisher, Access and Outlook are included in higher-priced versions of Microsoft Office.  Many free products such 
as WPS Office from Kingsoft, LibreOffice and Open Office also contain a spreadsheet.  Spreadsheets are very 
suitable for making multi-columned lists, especially if the rows and columns contain numbers that need to be 
manipulated - added, subtracted, averaged, cross footed, etc.  Examples:  A household budget with records of 
expenses per month or a list of investments including purchase price, sale price, dividend, percent return, etc. 
 
2007 and later - The Tab and Ribbon format for Excel 2007 reflects the same basic format as Word 2007.  This 
format remains consistent through versions 2010, 2013, 2016 and 2019. 
 

   
Note that the Home, Insert and Page Layout Tabs exactly mirror Word while the others are different.  With Excel 
even though the appearance of the two versions 2003 and 2007 are different, the contents of the spreadsheet 
(cells) look very much the same and therefore the end result will be the same. 
 
2003 and prior (and some free spreadsheet look-a-likes) - The toolbars in many of the Microsoft Products are 
very similar. (See diagram)  If you master one (e.g. in Word), you have taken a giant step to mastering the others.  
Excel, like Word, has a Menu Bar, a Standard Toolbar and a Formatting Toolbar.  These are the most frequently 
used.  There are other toolbars in common also.  Look for the differences… Some of the differences are: “Data” in 
the Menu Bar; “Sum”, “Function”, “Sort” and “Graph” in the Standard Bar; and “Centering Across Columns”, “%” and 
“$” in the Formatting Bar. 
 
 
 
 
 
 
 
 
 
 
 
All Versions - Mouse clicks work similarly in all versions too.  The left click tends to choose things.  The right click 
will usually reveal a menu.  The pointers can take on different forms.  A white cross (or plus sign) shows when you 
move the pointer over the worksheet, an “I-beam” appears when hover over the formula bar or over a double-

clicked cell.  (A single click on a cell highlights the cell.  A double click puts the cursor INTO that cell.)  The pointer 
is a black plus sign when pointing to the corner of a highlighted cell and an arrowed cross when pointing to the 
border of a highlighted cell.    An arrow shows when pointer is over a toolbar.  A double arrow shows when over a 
column or row boundary.  (Did you get all that?   Well it gets easier to remember as we work with it…honest!) 
 
Each cell is treated like a mini-document for formatting.  Formats that are used a lot have their own toolbar or 
ribbon entry (examples are $ and %).  As in most office products, you must highlight things in order to affect them. 
 
This write-up is best used when viewing or playing with a version of Excel or other spreadsheet. 
 

Menu bar 

 

Standard Bar 

Formatting Bar 
Formula Bar (unique to Excel) 

Tab Names 

Section Names 

Formula Bar 
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Excel - version 2007 and later (and Kingsoft (WPS) Spreadsheet) 
 
Discussion of the Ribbon 
 
The Home Tab in Excel 2007 looks very much like the common toolbars (standard and formatting) of 2003.  The 
items found on the formatting toolbar from 2003 are readily visible in the Home Ribbon.  The Window’s Logo in the 
upper left hand corner, pretty much replaces the File item from the Menu of 2003 version.   The functions for Open, 
Close, Save, Save As and Print are found under this Logo.   Page Setup which is found under File in 2003 is in the 
third Tab (page layout).  Here you can change the margins as well as the page orientation.  There are some 
commonly used margin combinations, but in the end you can get to the exact same window as 2003. 
 
A little searching under the various Tab headings will lead you to find the things that are not terribly obvious at first 
glance.  There is almost always a one to one match in functionality, but finding it in 2007 may take a minute.  After 
a little use it will prove to be fairly straight forward.  An excellent example of this is the item named Format Cells 
found under the Format menu item in 2003.   In version ’07 these items are visible all the time in the Alignment and 
Number sections of the Home Ribbon.  The same Format Cells choices are available under the Cells section of the 
Home Ribbon.  When there is a down pointing arrow by any glyph, clicking it will reveal more choices.  The Format 
icon has such an arrow and clicking it will reveal another menu. 
 
Just as in 2003, right clicking any cell will yield a formatting menu.  This is often the faster way to go.  Experiment 
with this to explore the items available.  Also, be aware that there are usually two or three ways of accomplishing 
the same thing.  Keyboard shortcuts, discussed several weeks ago do work.  Things like Ctrl-C for Copy, Ctrl-X for 
Cut and Ctrl-V for Paste.  Anotther handy one is Ctrl-Z for Undo. 
 
The Options entry under the Tools item in the Menu Bar from 2003 has a number of useful things under it.  In 2007 
the same list of things is found under the Excel Options found under the Office Logo (under the word "File" in 
versions 2010 and later).  If you were used to a non-ribbon format, you will discover that once you locate where 
something is in 2007 it will find that the same functionality as before. 
 
Commands for inserting and deleting rows or columns are found under the cells section of the Home Tab.  Use the 
dropdown arrow to reveal the appropriate choices.  As you may now begin to see, some commonly used items can 
be easier to access in this new layout.  The major objection to 2007 is that it is definitely different from prior 
versions and therefore meets with some opposition.  If you give it a chance you might find out that you like it better. 
 
Cell Manipulation - All versions 

 
Row height and column width can be adjusted in two ways.  You can point at the boundary between rows or 
columns (a double-headed arrow will appear), left click and hold and the drag to increase/decrease the 
width/height…or you can point to the boundary and with the double arrow appears, double click the mouse.  This 
will make an adjustment, up or down, to exactly accommodate the largest entry.  
 
Sometimes it is desirable to manipulate cells beyond formatting.  Manipulation can include sorting or performing 
arithmetic or logic functions on the contents. Formatting, as we’ve seen, includes not only content (font) type and 
size, but also color of letters/numbers, color of background, border, alignment in cell, rotation within cell and special 
applications such as currency or date.   
 
Arithmetic Operations 

 
Arithmetic operations are performed within cells by using the symbols ‘+’ (plus sign) for add, ‘-‘ (hyphen) for 
subtract, ‘*’ (asterisk) for multiply and ‘/’ (forward slash) for divide.  When a cell is highlighted the contents of that 
cell appear in the formula bar.  The formula bar also shows the co-ordinates of the cell (row and column).  Keep in 
mind that what is shown in the formula bar may look different from what is shown in the worksheet.  The worksheet 
is the product of formatting.   
 
As an example, to add the contents of two cells together you first enter an equal sign, followed by the cells numbers 
(row and column) separated by the plus sign.  In other words, if you want cell A3 to be the sum of the contents of 
cells A1 and A2, you would type the following into cell A3: "=A1+A2" (without the quote marks)     This takes the 

contents of cell A1 and adds it to the contents of cell A2 and puts the sum into A3.  The same principle applies to all 
arithmetic operations.  It is also permissible to use a constant number in a formula or cell manipulation.  If you 
wanted to multiply a number in cell A1 by 1.06 (to see the result of a 6% increase), you would put "=A1*1.06" in the 
destination cell. Arithmetic operations have a hierarchy… always multiply and divide before you add and subtract. 
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The hierarchy can be changed with the use of parentheses.  Work inside parentheses first.  There are many built in 
functions in Excel (e.g. Average, Square Root, If, Sine and Cosine) that we will touch on next week.  These are 
found in the Formula Library section of the Formula Tab Ribbon.  Try a few of these. 
 
Sorting   
 

These commands are present under the Data Tab in the Sort and Filter Section.  When you highlight a column for 
sorting you can click on the sort icon in the Data Ribbon.  This will order the column in ascending or descending 
order, depending on what you selected.   If you highlight several columns and use the sort icon from the ribbon, it 
will give you a dialog box asking what column you'd like to use as the primary sort.  There is a place in this box to 
designate whether there is a header (title) in each column.  Headers make it easier to sore.   Excel will warn you if 
you select a column for sorting and there are adjacent data that you have not selected.  If numbers and alpha 
characters are mixed the numbers all sort first. 
 
Excel File Types 
 
Remember the default extension on a document created in Excel 2007 and later is .xlsx.  (Just as Word 2007 and 
later automatically creates a .docx file)  It makes for smaller files but such files cannot be read by older versions of 
Excel (or Word).  If you know you are sending a document to someone who has a previous version of Excel, do a 
“Save As” and choose the format .xls.  That will convert it back to the “universal Excel format".  
 
This website http://office.microsoft.com/en-ca/excel/HA101491511033.aspx gives a good mapping of version 2003 
to Excel 2007.  This is a very good and informative interactive website.  So if you have recently acquired the new 
format and are used to the old one, this is a very valuable website.  Try it. 

 
Excel - Version 2003 and prior (and some free spreadsheets) 

(You can skip this section if you don't use Excel 2003 or one of the free spreadsheets) 

 
Very Useful Items Accessed from Menu Bar 

 
The dropdown menu under File has many entries that are the same as MS Word and have functions that are 

almost the same.  These include New, Open, Close, Save, Save As and Print.  The Page Setup entry, however, 
although it uses the same words as the MS Word menu has considerably different functions.  It has four tabs - 
Page, Margins, Header/Footer and Sheet.  Page allows you to set Portrait or Landscape orientation and do scaling.  
The Margins tab functions similarly to Word but lets you center the spreadsheet on the page horizontally and/or 
vertically (very useful).  The Sheet Tab allows you to define a print area as well as turn gridlines off the printing.  
With gridlines off, the only cell definition boundaries that show are one where you added a border line. 
 
The dropdown from Edit has many functions the same as Word, but in Excel there is a difference between Clear 

and Delete.  Clear has several options including All, Formats and Contents.  Clear All means to wipe out all 
contents and format in that cell.  Clear Format means to leave the contents alone and revert back to the default 
formats.  Clear Contents functions the same as hitting the delete key.  It leaves the formats alone and wipes out the 
content.  The Delete option from the menu offers the option of deleting the entire cell or row or column. 
 
Format from the menu give you options to format Cells (used most often), Rows, Columns and Sheet.  The Format 

Cells window gives you six tabs (You will be here often).  (Format Cells can also be accessed by right clicking any 
cell)  Here is their explanation of the tabs under Format Cells. 
 

1. Number - allows you to choose how numbers are displayed in cells.  There are twelve choices including 
currency, date, time fraction and other.  You can choose how many decimals will be shown as well as how 
to display negative numbers. 

2. Alignment - offers choices on how text appears in cells.  Permits rotation, wrapping and shrinking of text.  
This is where merged cells can be undone. (The most common use of merged cells is when centering a 
heading across columns) 

3. Font - This is where you can change size, bolding, text type etc. 
4. Border - Allows defining borders to cells  
5. Patterns - Deals with fill colors  
6. Protection - Allows you to ‘lock’ or ‘hide’ cells.  This is a useful feature if others have access to your 

worksheet and you want to make sure things don’t get changed.  Useful, too, to prevent accidental changes 
by you. 

 

http://office.microsoft.com/en-ca/excel/HA101491511033.aspx
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The Tools entry has an Options choice on its list.  The Options entry gives you a window with 8 tabs that are quite 
useful.  Here is an explanation of some of the items on the tabs. Others are best learned by experimenting. 
 

1. View - offers choices or what is seen on the computer screen.  Here is where you can turn off the gridlines 
(note: this is different from turning off the PRINTING of the gridlines).  Experiment with others 

2. Calculations - You can turn off automatic calculations (don’t) 
3. Edit - Most useful entries include: where to move selection after entry and disabling auto complete (Auto 

complete annoys some people) 
4. General - More choices including where excel looks for documents to open.  This is where you set the 

default font and size.  Also user name. 
5. Transition - Allows you to choose a default ‘save’ format 
6. Custom Lists - Permits you to edit or enter custom lists.  Days of the week and months are already there.  

You can add things pertinent to your applications. 
7. Chart - Option in graphing 
8. Color - Allows changing default font color and fill color 

 
Auto Correct, under Tools is another useful entry.  Here is where you find the list of misspellings that will be 
changed automatically, as well as some choice to check as to what is considered an error. 
 
Extra rows or columns can be inserted using the Insert Command from the Menu Bar.  Rows are inserted above 
the highlighted cell.  Columns are inserted to the left of the highlighted cell.  If you want to insert more than one row 
or column at a time, simply highlight the number of cells equal to the numbers of rows/columns you wish to add.   
 
Under Format Rows/Columns it is possible to change the height/width.  Remember, as always, you must highlight 
things in order to affect them. The Sheet entry allows you to rename a worksheet.  Hiding rows/columns or whole 
worksheets is also possible under the Format - Rows/Columns/Sheet.  This lets you get things out of the way if they 
need not be viewed all the time.  It also lets you conceal sensitive data and protect it with a password. 
 
Some of the items mentioned above can be done faster by using the formatting toolbar.  Also try right clicking in 
different places and you may be pleased at the dropdown menu that the right click produces.  Keep practicing and 
finding new or shorter ways to do things.  That’s the best way to get good at Excel or any other application. 
 
Sorting 
 
When you highlight a column for sorting you can click on the sort icon on the Standard Tool Bar.  This will order the 
column in ascending or descending order, depending on what you selected.   If you highlight several columns and 
use the sort icon from the toolbar, the first column is the default sort, with the other columns coming along for the 
ride.  If you want to sort one column in the middle of a selection you must use the Data entry on the Menu bar and 
then choose the column you want sorted.  Excel will warn you if you select a column for sorting and there is 
adjacent data that you have not selected.  If numbers and alpha characters are mixed the numbers all sort first.  As 
stated above, having a header or title on the column make things easier. 
 
Data filtering is another very useful feature of Excel.  You highlight the columns you wish to work with and choose 
Data and then Filter and the AutoFilter.  This allows you to enter criteria and have only those criteria show.  This will 
be covered in detail next week. 
 
Cell Manipulation 
 
The concept of cell manipulation and using arithmetic operation is exactly the same as in 2007, 2010 and later.   
 
Epilogue - If you decide not to buy MS Office, there are three Office Suites that are free that are suitable 
substitutes.  The others are Apache OpenOffice, LibreOffice and Kingsoft Office Suite - all of which are available 
from www.filehippo.com under the Office / News section.  The one with format closest to Excel 2007, 2010, I 
believe is Kingsoft.  All of these free Spreadsheets can be made to open "real" Excel files.  
 
Because of the variation in appearance of spreadsheet products, this write-up is more of an overview of what is 
possible, more than it is a "how to" document. What will serve you best is to settle on one spreadsheet program 
and concentrate on finding all the features and getting familiar with its operations and format. 
 

Dan Phelka 535-7791 


